COGNEX°®

DataMan® 50

Quick Reference Guide

DATAMAN
ID Readers



Getting Started

About DataMan 50 e For More Information e DataMan 50 Page 4

Systems ¢ DataMan 50 Accessories e Reader Layout

Setting Up Your DataMa Setting the Focus Position ¢ Dimensions e DataMan
50 Imager Specifications e Field of View and Reading

Distances

DataMan Software Installing DataMan Software and Connecting the Reader
e Start the Setup Tool ¢ Use the Setup Tool Menu Bar e

Triggering e Training the Reader e Read Setups

ConneCtlonsl OptICS, anc I/O Cable e Digital Input and Output Wiring Diagrams e
Illumination Strobe Output e Multi-Port Connections

Compliance Information DataMan 50 Specifications ¢ Warnings and Notices
and Notices Compliance Statements

ii DataMan 50 Quick Reference Guide DataMan 50 Quick Reference Guide iii



About DataMan 50 For More Information...

This document provides basic information about how to configure and

DataMan 50 is a compact fixed-
mount ID reader that among
others offers the following
advanced features:

e Smallest high-performance
fixed mount reader

e Highest read rates for 1-D and
2-D codes

e Reliability and image feedback

The DataMan 50 reader supports
RS-232 and USB interface L
connections in addition to discrete I/0. !

The DataMan 50 reader is packaged in a rugged, IP65-rated housing.

use the DataMan 50 reader. Additional information is available through
the Windows Start menu or the Setup Tool Help menu after you install
the DataMan software on your PC:

DataMan Communications & Programming Guide shows
how to integrate your DataMan reader with your automation
software and factory network.

Cognex->DataMan Software v x.x->Documentation->Communications &
Programming

DataMan Reader Configuration Codes provides printable
2-D codes that you can use to configure the DataMan reader.
Cognex->DataMan Software v x.x->Documentation->English->Reader Configuration
Codes

DataMan Fixed Mount Readers Reference is a complete
online hardware reference for the DataMan reader.

Cognex->DataMan Software v x.x->Documentation->English->DM50->Fixed Mount
Reference Manual

DataMan Questions and Answers provides context-sensitive
information. You can view this help inside the Setup Tool or as
a stand-alone help file.

Cognex->DataMan Software v x.x->Documentation->English->DM50->Questions and
Answers

Release Notes list detailed system requirements and
additional information about this DataMan software release.

Cognex->DataMan Software v x.x->Documentation->DataMan v x.y.z Release Notes
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DataMan 50 Systems

DataMan 50 Accessories

IDQuick™ —
Omni-directional ) IDMax+™ with
1-D Code Reading High-Speed 2-D HOTBARS™
Reading
DataMan 50L y
(DMR-50L-00)
DataMan 50S
(DMR-50S-00) v v v

CABLES
USB Cable, 1.5 m
(DM100-USB-000)
@ USB Cable, 3 m
(DM100-USB-030)
@ RS-232 Cable, 1.5 m
(DM100-RS232-000)
Extension Cable, 5 m
(DM100-EXTCBL-000)
@ RS-232/USB adapter
connector
(DM100-PATCH-000)

POWER SUPPLY

@ Power Supply, 6V
(DM100-PWR-000)

MOUNTING BRACKETS
Pivot Mounting Bracket
(DM100-PIVOTM-00)

CONTROL BOX
Control Box (DM-CTRLBOX-00)

DOCUMENTATION AND INSTALLER
DataMan 50 Quick Reference Guide
(this document) (590-7165)

DataMan 5.1 Thumb Drive
(DMA-USBST-510)

6 DataMan 50 Quick Reference Guide




Reader Layout

The following image shows the characteristics of the DataMan 50 reader.

Status LEDs

3-position
M12 lens yellow arrow
indicates selected

focus position
Internal
illumination
LED aimer S

Hidden square nut
as an alternative
mounting option

Remove side cover
Mounting holes to access square
(M3 x 3.5mm) nut (M3)
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Setting the Focus Position

DataMan 50 can operate in one of three distance ranges. To set the focus 4 Line up the holes with the icons, and attach the rubber part to
position: the front window.

1 Remove screws, lens cover, and rubber part.

2 Set focus by positioning a coin into the lens cap slit and turning the coin.
Do not use a coin thicker than 2 mm. If no coin is available, use the
edge of the back cover.

Lens cap slit

6 Tighten screws in order shown. Maximum torque for the cover
screws is 8 N-cm (0.7 pound-inch). The yellow arrow on the
cover indicates the selected focus position.

Make sure that the sealing and the sealing surface are clean before
reassembling the lens cover.
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Dimensions

Observe the following DataMan 50 reader dimensions when installing your
reader.

31.75mm
[1.25in]

- P
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DataMan 50 Imager Specifications

Field of View

Specification

DataMan 50 Imager

Image Sensor

1/3 inch CMOS

Image Sensor Properties

4.51 mm x 2.88 mm (H x V), 6.0
um square pixels

Image Resolution (pixels)

752 x 480

Electronic Shutter Speed

33 s to 25 ms exposure

Image Acquisition

up to 60 fps at full resolution

Lens Type

3 focal position M12 lens

This chart shows the horizontal field of view for the DataMan 50 at a
range of working distances.

The horizontal and vertical field of view is shown for working distances
of 45mm, 70mm and 110mm.

60

40

\ z 20
\ 34 x 22 |50 x 32 77 x 49

20

40

60
mm 20 40 60 80 100 120 140 160 180
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Reading Distances Installing DataMan Software and
Connecting the Reader

This chart shows the supported range of reading distances for four code sizes

gl61,(181,1100;11anr11§j 12 mil) at each of the three focus positions (45 mm, 70 mm, INSTALL DATAMAN SOFTWARE AND CONNECT
1. Check the DataMan Release Notes for a full list of system

requirements.

2. Insert CD-ROM and follow the on-screen prompts until you
successfully completed the DataMan Software installation process.

3. Connect the DataMan 50 reader to your PC.
. Launch the Setup Tool and click Refresh.
|

|1 | | Detected readers will appear under COM ports.

e

N

6 mil 5. Select a reader from the list and click Connect.

D o S CONNECT YOUR READER

8 mil

1. Connect the cable on the back of the device to either an USB

* adapter cable with power tap or to an RS-232 adapter cable with
3 10 mil power tab.

2. Connect either the USB or the RS-232 connector to your PC.

° 12 mil 3. Connect a 6V power supply.

mm 20 40 60 80 100 120 140 160 180
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Start the Setup Tool

Connect the reader to the Setup Tool to configure it with
the type of symbologies it will decode as well as other
parameters, such as the type of trigger it will use and the
format of the results it will generate.

Alternatively, configure your reader by scanning the
appropriate reader configuration code from the Reader
Configuration Codes document, available through the
Windows Start menu or the Setup Tool Help menu.

Quick Setup

All main controls and visual feedback in a single view, for
easiest setup and configuration

Connect to Reader

Establish a connection to the reader

Results Display

View results

Light and Imager Settings

Choose a trigger type and other acquisition parameters
System Settings

Configure visual and audio feedback, trigger and output
actions

Table View

See all the selectable values in the Setup Tool in one table

Trigger IN1
button button

Quick Setup

=3 Connectto Reader
-3 Results Display

{5 Read Setups

&% Light and Imager Setiings
@84 Symbology Seftings
~4£# Data Validation

s

[ Optimize Brightness | .

Optimize Focus

Train Code D

.
Lo

H  Trigger K Live Display

Latest image Code information _Reglon of Context based help
/ interest
ﬁ DMSD-‘,BSA&Q (DM50) [COMT7] - DataMan Setup Tool \ I = \ = —Eh
B\ gr)‘ Vew Tsks System Help
EN_FICHCN:Y
Tasks X QUiCk Setup Q+A Help. X
Image Display boHiZz Al 4
Quick Setup

¥ How do I save an acquired image to a file?

Select File->Save Image or dick the Save
Image button in the tool bar.

You can also drag and drop your image to your
PC. Click the image in the Image Display window,
drag it outside the Setup Tool and release it.

Note that in case you want to save an image with
drag and drop and the image is not the latest
(you are saving it from the Read Result History),
the image will be saved with the displayed image
settings. By default, itis of reduced qualty.
Under Displayed Image Settings, you can
change the image size ta full and the format to
Bitmap.

= How do I adjust the image exposure?
Click Optimize Brightness to aummah:a”v set

= 48¢ Data Formatting
Exposure 8] arecommended light intensity. This featur
wo Standard Formatting available if Manual Exposure control is sEIE(tEd
i "““m“”a’““" For further settings, dick the icon next to
. Perl-Style Regular Expre B el Focus Optimize Brightness button.
= [ Extemnal Click @ptimize Focus to set the best possible
[ ScriptBased Formatiing focus. This feature is only available for readers
Imager Seftings with a liquid lens. For further settings, cick the
 Communication Settings = s @ icon next to the Optimize Focus button.
DL RRREATEL You can also change the Exposure and Focus
System Settings [Singls fextemal) - Value settings, while experimenting with Live
< Display.
=+ Image Record and Playback Timeout [ms] 2000  bow 0 Tdpiat e wastt cxsosisdy
~-iiy Buffered Image Settings Read Result History Click Optimize Brightness to sutomatically set
3 ar i . This feature is
&t Process Monitor Deta Time Stamp  ~ available if Manual Exposure control is selected.
IE For further settings, dick the icon next to the
hitp://icaywa me/Dx89H 15:0956.810 ||£ further et
5] Table View [EoR S WD e NI Optimize Brightness button.
E x You can also change the Exposure and Focus
Value settings, while experimenting with Live
Display.
Clear History
P — = » =
Time Stamp: 15:09:56.510 | Data: hitp://kaywa.me/DxB9H | | Untrained Connected
1
Train
Read history status Connection status
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Use the Setup Tool Menu Bar

The In1 button on the toolbar creates a virtual rising edge signal on Input
1. Use the In1 button to activate various actions such as training a code,

optimizing brightness or setting a match string without a physical input 1
channel.

Each reader can store its current set of runtime parameters to a configuration
(.cfg) file, which contains information such as the enabled symbologies and
how any output data should be formatted.

The same configuration file can be loaded onto multiple readers, as the file
does not contain identification information such as the device name of the
reader used to create it.

A reader can also generate a Cognex device configuration (.cdc) file, which
stores the set of runtime parameters plus any identification data, such as the
name of the device. Cognex recommends generating a device configuration
file for each reader to allow you to restore a reader to its operating state with
minimal effort.

Use the File menu of the Setup Tool to manage .cfg and .cdc files, export
parameters, or to load, save, or train uploaded images.

File Menu

Open Configuration

Open a saved .cfg configuration file.

Save Configuration

Create a .cfg configuration file of current
runtime parameters.

Restore Device

Load a saved device configuration .cdc
file, with runtime parameters plus device-
specific information for a particular
DataMan reader.

Backup Device

Create a device configuration .cdc file for a
specific reader.

Export Parameters

Save (all or only the non-default)
parameters of your device in a text file.

Load Image

Load an 8-bit uncompressed grey-scale
.bmp or .jpg image for analysis.

Save Image

Save the latest acquired image with the
.jpg or .bmp file format.

Save Burst Images

Save the latest batch of burst images.

Train Image

Upload an image to be used for training.
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Use the Setup Tool Menu Bar (Continued)

DataMan 50 Triggering

Use the Edit menu for standard Cut, Copy and Paste operations.

Use the View menu to view reader information (serial number, firmware
version, and so on) and to enable and disable various elements of the Setup
Tool, and the Tasks menu to switch between various Setup Tool options.

Use the System menu to manage the current settings on the reader and to
upgrade the features it currently supports:

System Menu

Save Settings

Save the current parameters to non-volatile memory,
which allows the reader to restore these settings
each time you reboot it.

Reset Configuration

Reset all configuration parameters in RAM (volatile
memory) to the default settings.

Update Firmware

Update the reader software.

Upload Feature Key

Unlock additional features available in the reader
software if you have the right key.

Show Device Log

Error and exception conditions, such as missed
triggers and trigger overruns are logged.

Delete Device Log

Clear your device log.

Use the Help menu to display Setup Tool version information.

DataMan 50 readers support the following trigger modes:

Self: At an interval you configure, the reader automatically detects
and decodes codes in its field of view. If you set a higher re-read
delay than the trigger interval, there is a code output only once until
the code is out of the field of view for the duration of the re-read
delay.

Single (external trigger): Acquires a single image and attempts to
decode any symbol it contains, or more than one symbol in cases
where multicode is enabled. The reader relies on an external trigger
source.

Presentation: Scans, decodes and reports a single code in the
field of view. The reader relies on an internal timing mechanism to
acquire images.

Manual: Begins acquiring images when you send an external trigger,
and continues acquiring images until a symbol is found and decoded
or you stop the external triggering.

Burst: Performs multiple image acquisitions based on an external
trigger and decodes any symbol appearing in a single image or
within a sequence of images, or multiple symbols in a single image
or within a sequence of images when multicode is enabled. You can
control the number of images within each burst and the interval
between image acquisitions.

Continuous: Begins acquiring images based on a single external
trigger and continues to acquire and decode images until a symbol
is found and decoded, or until multiple images containing as many
codes as specified in multicode mode are located, or until the trigger
is released. You can configure your reader to acquire images based
on the start and stop signal from separate digital IO pulses.
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External Triggers

Training the Reader

If you are using external triggering you can use any of these methods to
trigger your DataMan 50 series reader:
e Send a pulse on the I/O cable:
e Input 0 (white)
e Input 1 (white/black)
e Send a serial trigger command over the RS-232 connection.

e Press <CTRL>-T on the keyboard while the Setup Tool has the input focus.

e Click the Trigger button in the Setup Tool:
File  Edit View

® 3

Training your reader with the expected symbology can make the time
required to decode successive symbols more consistent. In addition,
training may help increase decode yield.

To train your reader, place a code in front of the reader and do one of
the following:

e Click and hold the trigger button in Fle Edit View
the Setup Tool for a minimum of 3
seconds. @ g 3

e Click Train Code in the Results Display pane.

Results Display

Train Code l |

Optimize Brightness

e Upload the code through File menu - Train Image.

You can use training in Single, Burst, Continuous or Self trigger modes.

NOTE that only a single symbol of each symbology kind can be trained.
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Training the Reader (Continued)

Read Setups

Incremental Training for Multiple Symbologies

If you want to train the reader to recognize multiple symbologies, you can
present a single image showing all the desired symbologies and perform the
training procedure previously described.

If you cannot present a single image showing all the necessary symbologies,
you can enable incremental training on the Training tab of the Symbology
Settings pane:

Symbology Settings

Generall Multicode  Training I

¥ Incremental Training

With incremental training enabled, you can train the reader using multiple
images showing the symbologies you expect to decode. The reader will train
each new symbology while retaining the existing trained symbologies.

It is possible to configure a variety of acquisition parameters for your
DataMan 50 reader on a unified Read Setups pane.

Read Setups

Starting Setup

o i 0
Add Setup Last Successful Decode
Parameter Setup 0 Setup 1
Name Setup 0 Setup 2
Enabled v V|
E. Light and Imager Settings
Exposure (is) 0 200
Gain |24 D 2
=l Mumination
| Intemal ] ¥
Intemal Intensity 15 £ 15

Extemal

Your reader can be configured for up to 16 different settings. In Single
trigger mode, you can enable multiple (or all) setups, and the DataMan
50 reader goes through all of the configured imager combinations until
there is a decoded image or there are no images left (that is, a no read
image).

You can change the parameters for the setups either on its dedicated
pane, or in the Read Setup pane’s appropriate table cell. Whatever you
change on either pane is mirrored on the other.

The read setup process starts with either a specific setup, or the Last
Successful Decode (as you choose).

The currently selected setup also gets represented on other panes.
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I/0 Cable

Digital Input Lines

The I/0 cable provides access to trigger and high-speed outputs. Unused wires
can be clipped short or tied back using a tie made of non-conductive material.

For RS-232, use the Power Supply return path for ground.

PIN | Color Signal

1 Brown Reserved

2 Green TxD

3 Green/Black RxD

4 Red & Red/Black | GND

5 Brown/White DC+ (system power,
5-24 VDC)

6 Blue RTS

7 Blue/White Output-0

8 White Input-0

9 White/Black Input-1

10 Light Blue CTS

11 Light Blue/Black | Output-1

12 Light Blue/Yellow | Output-Common

13 Light Blue/Green | Output-Strobe

14 Yellow Reserved

15 Yellow/Black Reserved

Inputs are not galvanic isolated but need to be referenced to ground.

Constant 2mA
current sink

+Va

Input-Internal-1/
Input-Internal-2

Input-0/Input-1 e (Internal Signals)

ESD Protection

i
I
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Digital Output Lines

The digital outputs can be used as either NPN (pull-down) or PNP (pull-
up) lines. For NPN lines, the external load should be connected between
the output and the positive supply voltage (<26V). The outputs pull
down to less than 3V when ON, which causes current to flow through
the load. When the outputs are OFF, no current flows through the load.
Outputs are not galvanic isolated but need to be referenced to ground.

DSP output o
signal

:

:

o€
g

JF<|__. Output_Common

PTC —e Output_|O
50mA

NE
1

NPN (pull down) output type characteristics are the following:

PNP (pull up) output type characteristics are the following:

Output voltage range 26V or less
Residual voltage 0.8V or less
Maximum source current 25mA

Short-circuit current

50mA or less

Short-circuit protection

multifuse - 50mA

Applied voltage

26 VDC or less

Residual voltage

0.85V or less

Maximum sink current

25mA

Short-circuit current

100mA or less

Short-circuit protection

multifuse - 50mA
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Illumination Strobe Output

The strobe output is provided by a diode that is added to the push-pull circuit,
with series to the pull-up transistor. This diode blocks the higher voltage when
the output is pulled up when used as open-collector type driving, but enables
the driving of high level in TTL mode.

TTL output type characteristics are the following:

High level 4.0-5.0V

Low level 0-0.4V

Output current 25mA
Short-circuit current 125mA
Short-circuit protection multifuse - 50mA

Open-collector output type characteristics are the following:

Output voltage range 0-26V

Low level 0-0.4Vv

Output current 25mA max
Short-circuit current 125mA
Short-circuit protection multifuse - 50mA

The following figure shows the wiring diagram of the illumination strobe

output.

+5VDC

[

i

Strobe
(Internal signal)

=

NI

Output-Strobe

L
\ ESD Protection
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Multi-Port Connections

You can connect multiple DataMan 50 readers to a single PC (or other device
equipped with a serial port) using a multi-port connection.

A multi-port connection creates a daisy-chain of readers. Each reader receives
serial data from the previous reader and transmits it to the next reader. When
a reader transmits data, it is passed through each of the readers in the chain
between it and the PC.

il
ﬂ

= LA =

T
e Pl |
Because of the large number of possible configurations, Cognex does not
supply cabling for multi-port DataMan 50 connections. Instead, you must
construct your own cable that meets the requirements of your system
configuration.
The cable must provide a DB-9 connector for each DataMan 50 serial cable and
a DB-9 connector for the PC serial port. Each DB-9 connector must provide Tx

Data, Rx Data, and ground. The Tx Data and Rx Data pins on adjacent
connectors must be connected to provide the multi-port connection.

The following diagram shows how to create a multi-port cable for a
3-reader system:

DataMan 50 DataMan 50 DataMan 50
A

2:Tx Data
3:RXData A g A T g A g
S ED [N RS 3o [ORCCRORS
rc 4

2:Rx Data

3:Tx Data

5:GND
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Configuring for Multi-Port Operation

Multi-Port Usage Notes

You must connect the Setup Tool to each DataMan 50 in turn and enable multi-
port operation. Click the Communication Settings task and check the Enable
Multi-Port (RS-232 Sharing) check box.

Enable Mutlti-Port {(R5-232 Sharing)

There is no guaranteed delivery order when multiple readers transmit data
using a multi-port connection; read results may arrive at the PC in any order.
You can configure each DataMan 50 reader in a multi-port connection to add
identifying data to each read result. Your PC application can then determine
which reader produced a specific read result.

To do this, click on the Data Formatting task, click the appropriate Standard
box (for each symbology that you are using), go to the Standard Formatting
pane, and enter text in the Leading Text field. (You can also add trailing text
by entering text in the Terminating Text field.)

Data Matrx | QR Cods | 1D / Stacked / Postal | Uriversal

Leading Text
Reader1

Data
| General | Valdation |
|| «Sub-string>

<Full siring>

ml s

You can obtain the best results when using multi-port connections by
keeping the following usage guidelines in mind as you design your
system:

The maximum cable length between any two DataMan readers or
between the PC and any DataMan reader should be no greater than
15 meters.

There is no fixed limit to the number of DataMan readers that you
can connect to a single PC. Each reader introduces a delay of about
100 msec when it retransmits received serial data. If you have 5
readers, this means that there will be a 400 msec delay between the
time the first reader in the chain transmits data and the PC receives
it.

Each DataMan reader must receive a hardware trigger signal on its
Input O line. You can wire the input ports to a common trigger signal
or you can provide individual triggers for each reader.

If any reader in the multi-port chain loses power or becomes
disconnected, then no data from any other reader will be
transmitted.

If a DataMan is transmitting its own read result, it will buffer any
data received from another reader until it has finished its own data
transmission. If a DataMan reader is transmitting another reader’s
data, it will buffer its own data if it receives a trigger signal while it is
processing the other reader’s data.

If you use a single power supply for multiple readers, make sure that
the power supply can provide enough power for all of the readers.
You cannot connect a reader to the Setup Tool over RS-232 once
multiport is enabled. You must first scan the Disable Multi-Port code
from the Reader Configuration Codes, available from the Start
menu.
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DataMan 50 Specifications

Warnings and Notices

Weight

76 g (including cable)

Operating Temperature

0°C — 40°C (32°F — 104°F)

Storage Temperature

-10°C — 60°C (-14°F — 140°F)

Maximum Humidity

95% (non-condensing)

Environmental P65
Vibration EN61373 including IEC 60068-2-6,60068-2-64 6.4, and 60068-2-27
Codes Data Matrix™ (IDMax: ECC 0, 50, 80, 100, 140, and 200; IDQuick: ECC200)
Vericode (optional)
QR Code and microQR Code, MaxiCode
UPC/EAN/JAN
Codabar, Interleaved 2 of 5, Code 39, Code 128, and Code 93, Pharma,
Postal, RSS/CS, PDF 417, MicroPDF 417
Discrete I/O Output 0,1 Ivax @ 24 VDC 25 mA
operating limits Vmax 26 Vv
Output 2 Source Vrve 4 Vv
Sink Vin 4-\esy V
Vi 0—2 Vv
Input 0 (Trigger) ViH 4—26 Vv
Input 1 Vi 0—2 \
lrve 3 mA

Power Supply
Requirements

Vesu 4,5 — 26VDC
2.5 W maximum
LPS or NEC class 2 power supply

0 NOTE: For product support, contact http://support.cognex.com
CAUTION: IP protection is ensured only when all connectors are
attached to cables or shielded by a sealing cap.

CAUTION: LED RADIATION - DO NOT VIEW DIRECTLY WITH
OPTICAL INSTRUMENTS - CLASS 1M LED PRODUCT
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Compliance Statements

DataMan 50 readers meet or exceed the require-
ments of all applicable standards organizations

for safe operation. However, as with any electrical
equipment, the best way to ensure safe operation is
to operate them according to the agency guidelines
that follow. Please read these guidelines carefully
before using your device.

Regul. Specification

USA FCC Part 15, Subpart B, Class A

Canada ICES-003, Class A

European EN55022:2006 +A1:2007, Class A

Community |EN55024:1998 +A1:2001 +A2:
2003

Australia C-TICK, AS/NZS CISPR 22 / EN
55022 for Class A Equipment

Japan J55022, Class A

FCC Class A Compliance Statement

S

This equipment has been tested and found to
comply with the limits for a Class A digital device,
pursuant to Part 15 of the FCC rules. These limits are
designed to provide reasonable protection against
harmful interference when the equipment is oper-
ated in a commercial environment. This equipment
generates, uses, and can radiate radio frequency
energy and, if not installed and used in accordance
with the instructions, may cause harmful interfer-
ence to radio communications. Operation of this

equipment in a residential area is likely to cause harmful
interference, in which case the user will be required to
correct the interference at personal expense.

Canadian Compliance

This Class A digital apparatus complies with Canadian
ICES-003.

Cet appareil numérique de la classe A est conforme a la
norme NMB-003 du Canada.

C-Tick Statement

v

Conforms to AS/NZS CISPR 22/ EN 55022 for Class A
Equipment.

European Compliance

(€

The CE mark on the product indicates that the system
has been tested to and conforms to the provisions
noted within the 2004/108/EEC Electromagnetic Com-
patibility Directive.

For further information please contact:
Cognex Corporation
One Vision Drive
Natick, MA 01760
USA

Cognex Corporation shall not be liable for use of our
product with equipment (i.e., power supplies, personal

computers, etc.) that is not CE marked and does
not comply with the Low Voltage Directive.

local or regional waste administration.

You may also contact your supplier for more
information on the environmental performance
of this product.

For European Community Users

Cognex complies with Directive 2002/96/EC

OF THE EUROPEAN PARLIAMENT AND OF THE
COUNCIL of 27 January 2003 on waste electrical
and electronic equipment (WEEE).

This product has required the extraction and use
of natural resources for its production. It may
contain hazardous substances that could impact
health and the environment, if not properly
disposed.

In order to avoid the dissemination of those
substances in our environment and to diminish
the pressure on the natural resources, we encour-
age you to use the appropriate take-back systems
for product disposal. Those systems will reuse or
recycle most of the materials of the product you
are disposing in a sound way.

X

The crossed out wheeled bin symbol informs

you that the product should not be disposed of
along with municipal waste and invites you to use
the appropriate separate take-back systems for
product disposal.

If you need more information on the collection,
reuse, and recycling systems, please contact your
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Reader Programming Codes

Reset Scanner to

Factory Defaults Reboot Scanner
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